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Abstract

Patients suffering from severe brain injuries may experience the unfortunate condi-
tion of being conscious, but unable to interact or communicate with the outside
world. In these cases, the lack of communication does not allow doctors to have
a complete understanding of patients’ state of consciousness leading to misdiag-
nosis compromising the choice of the best treatment. The use of Brain-Computer
Interface (BCI) is a promising strategy to analyse brain signals and evaluate the
presence of consciousness.

The proposed project aims at realizing a low-cost non-invasive BCI able to detect
and distinguish consciousness states through the use of electroencephalographic
(EEG) and electromyographic (EMG) signals. We initially recorded from healthy
subjects to train our algorithm. The method involves a pre-processing part,
entirely realized on MATLAB, to clean the raw EEG signals and obtain Readiness
Potentials (RP), a special type of Event Related Potentials (ERP), giving a measure
of the intentionality behind motion. Machine learning algorithms are successively
devoted to the classification of the movement between voluntary, semi-voluntary
and involuntary with the extraction of peculiar RP features.

After an introduction on consciousness and its states, the brain anatomy and
the recording methods, this thesis will focus on enhancing the pre-processing
algorithm devoted to the automatic correction of EEG artifacts. In particular, it
will be discussed (1) the different artifacts affecting the EEG signal; (2) the use of
Independent Component Analysis (ICA) to detect and correct them in frequency
and time domain; (3) the analysis of different detrending method to remove slow
drifts; (3) the improvements obtained on the RPs.

We recorded EEG and EMG also from hemiplegic patients asking them to
perform or imagine to perform a motor task. The application of the pre-precessing
chain to these signals will be discussed to prove the presence of intention and motor
programming exploiting Lateralized Readiness Potentials (LRP).
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Chapter 1

Consciousness

What is consciousness? Is it related to the body? How? The answers to these
questions have been matter of controversy between philosophers from the earliest
days and they are still importantly related to morality and free will topics.

In this chapter, different concepts of “consciousness” and the two main theories
of mind will be introduced; then, the neuroscience point of view will be discussed
through the Neuronal Correlates of Consciousness (NCC); lastly, the levels of
consciousness and related disorders will be described.

1.1 Definition and theories of consciousness

The term “consciousness” derives from the Latin verb conscire composed by con-
«with» and scire «to know»; probably, a loan-translation of the Greek word synedei-
sis [1]. Tt is commonly defined as the ability to know and perceive [2] or the state of
being awake, thinking, knowing and understanding what is happening around us [3].

The concept of consciousness has been notoriously discussed by philosophers
over the centuries: they have been trying to define what allows human being to be
conscious and whether this ability is intrinsic with the body or not. From Plato
to Freud, the discourse has brought to two main theories: Dualism and Materialism.

The Western philosophers Plato and Aristotle can be considered as the precursors
of Dualism since they recognized the distinction between body and soul. However,
it is only with René Descartes that the mind-body problem became a central topic.
In his arguments, Descartes sustained that the body is a material thing with a
measurable extent and sensitive to the laws of physics; on the other hand, the mind
is immaterial, lacking of spatial extension and not measurable. The distinction of
these two substances raised many objections against Descartes. In fact, he tried to
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Consciousness

explain that the concurrence of feelings and physical events was due to a structure
in our brain where mind and body could interact, but this was not enough to
convince Materialists.

Materialism claimed that everything existing is made of matter and, conse-
quently, that mental and brain states are identical and can be proved scientifically.
Following this idea, more radical theories were proposed, but the attempts of giving
satisfying demonstrations became more complex than expected. The relationship
between brain and phenomenal properties was, and still is, difficult to understand
since one can be present without the other. The problem of explaining the connec-
tion between specific conscious and brain states in a fulfilling way is unique and
Joseph Levine summarized it in the expression “the explanatory gap”. Similarly,
David Chalmers articulated the phrase “the hard problem of consciousness” to
identify the difficulty of explaining the physical processes giving rise to the sub-
jective feelings and sensations of conscious experiences, also known as qualia. On
the other hand, Chalmers defined “easy problems” the ones relating more with the
functions of consciousness: the ability to discriminate and categorize stimuli, the
ability of a cognitive system to access its own internal states and the difference
between wakefulness and sleep. Therefore, also Materialists missed something to
explain consciousness.

Neuroscience started playing a key role to provide some answers and, in the end, it
merged with philosophy into a single study called neurophilosophy which is still
working to solve the mystery behind consciousness.

1.2 Neurological point of view

Neuroscientists define consciousness as everything we experience, but they recognize
that brain’s complexity and conditioning do not allow a logical argumentation
for a full explanation. Putting aside the philosophers’ question of why we have
particular feelings, they focus on the scientific exploration of Neuronal Correlates
of Consciousness (NCC), i.e. the minimal neuronal activity mostly correlated with
the presence of consciousness [4].

It is possible to distinguish different aspects involving conscious experiences:

o level of vigilance, the state of attention needed to live psychic activities in
contact with ourselves and the surrounding environment;

o peripheral correlates of consciousness, corresponding to the modification oc-
curring with the different levels of vigilance;

o clectrical brain activity, expressing the functional level of the cerebral cortex
through dedicated instruments;
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o contents of consciousness, related to all the mental activities as perceptions,
feelings and thoughts occupying our mind on a given moment;

o self memory, meaning the continuous comparison between the sensorial inputs,
personal past experiences and perception of oneself identity implicating a
given behaviour;

o selective attention, defined as the mental concentration and focus on a given
content.

These characteristics can be associated to different parts of the thalamocortical
system, composed by the cerebral cortex and the thalamus, whose interactions are
necessary to generate the processes corresponding to conscious scenes.[5]

1.2.1 Theories of consciousness

The two most popular theories of consciousness in neuroscientific world are the
Global Neuronal Workspace theory (GNW) and the Integrated Information
Theory(IIT). Both recognize two properties of consciousness:

o Integration. Every conscious experience, independently from its content,
consists of a single and independent “scene”. It is also private and unique,
since it is experienced from a particular point of view which cannot be shared.

« Differentiation. A given conscious state implies an extremely rapid selection
among a collection of different states large as much as one’s experience and
imagination, and it may lead to different thoughts or actions. [6]

GNW, by Bernard J. Baars and others, observes that being conscious of some-
thing implies that many parts of the brain have access to that information, while
the localization of specific motor system implies unconsciousness. Therefore, GNW
states that consciousness arise when sensory information is broadcast globally to
multiple systems processing the data.[4]

IIT, developed by Giulio Tononi et al., considers the experience as intrinsic,
structured, specific-distinct, unified and definite. Consequently, any complex and
interconnected mechanism able to encode cause-effect relationships will have a level
of consciousness, provided that it does not lack of integration and complexity. In
other words, consciousness is the intrinsic causal power associated with complex
systems as human brain. IIT also provides a measure of consciousness through a
single non-negative number ®: if & = 0 the system is not conscious; the higher &,
the more intrinsic causal power the system possesses and the more conscious it is.
Human brain has a high specific connectivity which implies high ® and then very

3
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high level of consciousness.[4]

The emphasis on integrated information and complexity as hallmarks of conscious-
ness is well seen by many researchers that developed new theories starting from
it.

1.3 Levels of consciousness

A normal state of consciousness is composed by:

e phenomenal consciousness, or arousal, referring to the state of alertness or
wakefulness and clinically corresponding to the spontaneous eye opening;

» focal consciousness, or awareness, describing the subjective experience and
deducted by the ability to follow commands [7].

Given these aspect, it is possible to represent every level of conscious experience
in a two-dimensional space (Figure 1.1). However, under some conditions, it
is not possible to asses an individual’s level of consciousness. New researches
starting from the II'T, designed an empirical measure of brain complexity, called the
Perturbational Complexity Index (PCI). It measures the amount of information
in the integrated response of the thalamocortical system to a perturbation and
it was used to discriminate levels of consciousness between healthy subjects and
brain injured patients. The analysis involved recordings of transcranial magnetic
stimulation (TMS) evoked potentials and obtained promising results.

4
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e @ e —— e — Conscious
experience
®

or arousal

[
Light sleep

L L
Deep sleep lll REM sleep Lucid
Pt dreaming
/ thesi
. anesthesia

Content of Consciousness or vividness of contents

or vigilance, or wakefulness,

Level of Consciousness

Figure 1.1: Two-dimensional representation of different level of consciousness.
The vividness of the experience is represented on the X axis; the wakefulness,
vigilance or arousal are represented by the Y axis. Red indicates the clinical
conditions; yellow the normal physiological states. Taken from [8].

1.3.1 Disorders of consciousness

As previously mentioned, some conditions do not allow to determine the presence
of consciousness and its level. This is what happens to brain injured patients.
While some may completely lose their brain functions, i.e. incur in brain death,
those surviving may rapidly recover from coma or go through different states of
consciousness before getting back. Others, instead, may remain in one of these
states depending on the damaged structure.

The disorders of consciousness that can occur are:

o Coma: the acute state during which patients are neither aroused nor aware;
the eyes are constantly closed and not manifesting voluntary responses. There
are changes in the control and regulation of basic vital functions. This state
cannot last longer than 4 weeks, but it depends on the patient’s medical
condition and age. Recovering from coma may lead to vegetative state,
minimally conscious state or, rarely, locked-in syndrome.

» Vegetative State (VS): clinical condition which may occur after coma, it is
characterized by the absence of consciousness and responsiveness, a sufficient
preservation of neurovegetative functions and motor reflex, and normal sleep-
wake cycle. Patients in vegetative state give no signs of self-consciousness or

5



Consciousness

awareness of the environment and can not communicate with others. However,
there is a motor response to pain, but not a voluntary avoidance, and cranial
nerves and spinal reflexes are preserved.

« Minimal Conscious State (MCS): condition in which patients are aroused
and manifest self or environment awareness through minimal behaviours. The
behavioural responses of a patient in MCS are inconsistent, but reproducible
and they can be sustained long enough to be differentiated from reflexes. MCS
can occur after coma or be the evolution of a previous vegetative state; it
can last a short period or for a more or less indefinite time until the patient’s
death.

Locked-In Syndrome (LIS) is not a disorder of consciousness, but a state of
awareness and vigilance with the concurrent condition of quadriplegia and paralysis
of lower cranial nerves. Patients with classical LIS can communicate by blinking or
through vertical eye movement; in case of incomplete or total LIS, ocular movements
are difficult or totally absent. [9] [10] [11]



Chapter 2

The brain

The brain is the most important organ in the human body, but it is also the
most complex. Each part is specialized in important functions as body control or
interpretation of informations received from the outside.

In this chapter, the main components of the brain and their role will be presented
to have a better idea of how disease and injuries can affect it.

2.1 The anatomy of the brain

The human nervous system is composed by two parts:

+ the Central Nervous System (CNS), which analyses the received informa-
tions and generates appropriate answers;

« the Peripheral Nervous System (PNS), perceiving inside and outside
stimuli and transmitting the answers elaborated from the CNS.

The CNS includes brain and spinal cord which are both protected by the skull
and meninges, i.e. three layers of tissue called Dura Mater, Arachnoid and Pia
Mater. Moreover, a watery substance called Cerebrospinal Fluid (CNS) cushion
from injuries, washes out waste and impurities, and delivers nutrients.[12][13]
The brain is composed by three parts: cerebrum, cerebellum and brainstem.

Cerebrum

The cerebrum is the largest part of the brain and it is divided into two major parts,
right and left hemispheres. The two are separated by the great longitudinal fissure,
but connected by the corpus callosum which delivers messages from one half to the
other. The surface of the cerebrum consists in a grey matter layer called cerebral
cortex. It is possible to identify four functional sections for each hemisphere:
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Human Brain Anatomy

Frontal lobe Parietal lobe

Occipital lobe

Cerebellum
Temporal lobe

Spinal Cord

Figure 2.1: Brain anatomy. The brain is composed by three parts: cerebrum,
cerebellum and brainstem. Each hemisphere of the cerebrum can be divided in
four lobes. Taken from [12]

o Frontal lobe: located in the front of the head, it is the largest lobe and
it is responsible for intellectual and behavioural functions, and for speech
and motor ability; in particular, the areas planning voluntary movements are
located in the premotor area, while those producing movements in the primary
motor cortex.

o Parietal lobe: it is the middle section of the brain processing sensory
information to identify objects and understand spatial relationships; it is also
involved in pain and touch interpretation.

« Temporal lobe: located at the side of the hemisphere, it is involved in
visual and verbal memory, and its backside enables the interpretation of other
people’s emotions and reactions.

o Occipital lobe: the back part of the brain involved in processing visual
informations as colours and shapes received from the retinas of the eyes.
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Damages to these lobes affect their functions.[14][13][15]

The cerebral cortex communicates through white matter with deeper parts
usually responsible of essential behaviour for survival. In particular:

o the thalamus, consisting of two symmetrical egg-shaped masses, is located
above the brainstem with neurons radiating out through the cerebral cortex;
it serves as relay station for almost all the informations that come and go to
the cortex transmitting messages to the appropriate areas;

o the pituitary gland, a small gland located at the base of the brain behind the
nose, controls other endocrine glands in the body;

o the hypothalamus, a small structure at the base of the brain near the pituitary
gland, handles informations from autonomic nervous system and controls
hunger, emotions, temperature regulation, and circadian rhythms;

o the amygdala, a cluster of nuclei located close to the base of the brain, is
involved in functions including memory, emotion, and the body’s fight-or-flight
response;

e the hippocampus, a structure located in the temporal lobe, is important in
memory, learning and in the control of emotional responses;

o the pineal gland, located behind the third ventricle, helps regulate the body’s
internal clock and circadian rhythms with the secretion of melatonin.[12][13][15]

Cerebellum

The cerebellum is the second largest part of the brain. It has an ovoid structure
weighting 130 g-140 g and located beneath the posterior occipital lobes, behind
the brainstem. It has left and right hemispheres connected by the vermis and
an interior central tissue, called arbor vitae, spreading branches and sub-branches
through the hemispheres. The cerebellum has the primary function of maintaining
posture and balance by controlling the tone of muscles and limbs’ position, but it
also fine-tunes movements.[12][16]

Brainstem

The brainstem is the lower extension of the brain in front of the cerebellum and
connecting the spinal cord. It consists of three structures: medulla oblongata,
pons and midbrain. It passes messages between the various part of the body and
the cerebral cortex, but, more importantly, it controls involuntary functions as
respiration, digestion, circulation and reflexes.[12][14]
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2.2 Neurons and glial cells

Neurons are the fundamental unit of the nervous system. A neuron consists in
three parts:

e soma, containing nucleus and cytoplasm,;

o dendrites, small extensions of the soma acting as antennas picking messages
from other neurons;

o axons, extended structures specialized in the transmission of the information
through synapsis.

It is possible to classify neurons as:

o primary sensitive neurons, if they transmit the information from sensorial
parts to the nervous system;

o motor neurons, if they transmit information from the nervous system through
synapsis with muscles;

e interneurons, neurons transmitting to other neurons.

incoming
messages
received
by dendrites

neurotransmitter

message

receptor

Figure 2.2: Neuron’s structure and signal transmission. The incoming messages
from dendrites travels along the axon and are transmitted to other neurons through
synapsis.[13] Taken from [15]

Glia cells are non-neuronal cells outnumbering neurons by about 50 to one. They
sustain the nervous system and its processes through nourishment, protection and
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structural support. Indeed, they form a barrier protecting the brain and the spinal
cord against chemical substances coming from blood. Moreover, they contribute to
neuronal communication and neurochemical signal transmission.[15][17]

2.2.1 Neurons electrical activity

Neurons generate two types of electrical signals:

« action potentials, discrete voltage spikes propagating along the axon to its
terminals and essential for cell-cell communication;

Action potential
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Figure 2.3: Action potential passing a point on a cell membrane. The resting
membrane potential is —70mV. If the stimulus increases the potential above the
threshold, it keeps increasing and sodium ions enter. When the peak is reached,
potassium ions exits with a repolarization. Before going back to the resting state,
the membrane potential hyperpolarizes for a small period. Taken from [18]

« postsynaptic potentials, voltages arising when neurotransmitters bind to
receptors and are able to initiate (excitatory postsynaptic potentials) or inhibit
(inhibitory postsynaptic potentials) action potentials.
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Excitatory synapse Inhibitory synapse
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Figure 2.4: Postsynaptic potentials can be: excitatory (left), the presynaptic
terminal releases glutamate which allows depolarization of the membrane with
positive ions (Na+); inhibitory (right), the release of GABA causes the entrance
negative ions (Cl-) and the hyperpolarization of the membrane. Taken from [19]

While action potentials last 1 ms and can be measured with a microelectrode into the
brain in an in vivo recording, this is not possible with postsynaptic potentials even
if they can last tens or hundreds of milliseconds. Postsynaptic potentials are mainly
generated by pyramidal cells, the main type of neuron in the cerebral cortex. When
an excitatory neurotransmitter is released from presynaptic terminals in apical
dendrite, it causes an electrical current (positive ions flow) from the extracellular
space into the cell and a negative voltage outside the apical dendrites; the current
flows through the neuron exiting in the region of the cell body and the basal
dendrites (Figure 2.5). The dipole created by this process on a single neuron
can not be measured with scalp electrodes; however, if neurons receives the same
input and have the same orientation, the summation of dipoles will make possible
recording local field potential.[20)]
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Axons from
presynaptic cells

Apical dendrite =S

Cell body

Basal dendrites

Postsynaptic cell axon

Figure 2.5: Scheme of neurotransmission in a pyramidal cell. An excitatory
neurotransmitter released from presynaptic cells in apical dendrites causes the
positive ion flow inside the postsynaptic neuron and negative on the outside region.
The positive current flows through the neuron exiting in the cell body region and
basal dendrites. Taken from [20]
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Chapter 3

Biosignals and Readiness
Potentials

As previously said, consciousness is still a mystery and a challenging topic espe-
cially in neuroscientific research. The actual assessment of a patient’s state of
consciousness is based on attitudes and responses which can be voluntary or not.
Consequently, the possibility of having inaccurate diagnosis or misdiagnosis is large
and depends on the severity of brain injuries. The integration of neurofunctional
imaging to behavioural assessment can overcome these limitations and make the
detection of consciousness in non-responsive patients more accurate.

In this thesis, it is presented a project conducted in collaboration with the Univer-
sity of Essex and aiming at the implementation of a non-invasive Brain Computer
Interface(BCI) allowing the user to send neuronal commands to a controller inter-
preting and classifying motor actions. The high correlation between consciousness
and intention of voluntary movements, whether performed or imagined, has been
studied through Event Related Potentials (ERP), voltages arising in the brain
consequently to a specific stimulus or event.

This chapter focuses on the relation between awareness and motor intention, the
biosignals and the particular type of ERP, called Readiness Potentials, essentials
for this project.

3.1 Conscious intention and motor cognition

As largely demonstrated in neuroscience, consciousness is closely related the con-
cepts of free will and motor intention, whether the action is performed or just
imagined. Conscious experience requires awareness of one’s own actions and their
ability to control them. However, it is important to make some distinction between
some concepts:
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Movement’s intention: the decision and urge to move;

o Consciousness of the intention: the awareness of wanting to move;

Consciousness of the in progress motion: the knowledge of moving;

o (Consciousness of completing the programmed movement: the awareness that
the action has been performed as wanted.

Motor consciousness requires the sense of agency through one’s body. Many
researches focused on the individuation of specific brain areas determining the
conscious experience leading to action’s fulfilment. Patrick Haggard, professor of
neuroscience at the University College London, studied the conscious intention and
motor cognition. He concluded that any voluntary movement requires unaware
motor preparation preceding the decision of take action, i.e. the conscious intention.
Consciousness of motor intention activates the front pre-supplementary motor area
(SMA) and, then, it is independent from the movement execution. Indeed, damages
to the motor cortex can cause paralysis, while injuries to premotor areas generates
more complex deficits in motor cognition altering awareness and intentionality.
Movement awareness is then strictly related to the motor preparation stages.
Blakemore, Wolpert and Frith developed a model reflecting the sequence of events
producing and controlling the motor execution (3.1). The basic blocks composing
the model are:

e Motor planning: it generates the motor commands necessary to compute
the desired state comparing it with the actual state; then, it creates two copies
of the motor sequence: one for the motor cortex and the other for the predictor
block;

« Prediction model: it estimates the sensory consequences (predicted state)
of the programmed action before performing the movement.

o Comparator A: it compares the predicted state with the desired state; if the
two coincide then the subject gets the perception of performing the action,
the so-called “sense of agency”, before execution;

o Comparator B: it compares the implemented state, i.e. after movement,
with the desired state; if they coincide, the subject is aware that the movement
has been performed.

This model highlights the link between conscious intention and motor cognition
to program the movement and to be aware of the effects produced in the external
environment.[21][22]
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Figure 3.1: Computational framework for action.

Important studies by Berti et al. demonstrated that damages to the comparator
B lead to disorders as anosognosia for hemiplegia, a transient condition in which
patients are partially paralysed and claim to be able to move with the paralysed
parts of their body. In this cases, the motor intention and planning prediction
are preserved, which means that their sense of agency is generated correctly, but
the comparison computed between implemented state and desired state is not
correct.[23]

3.2 Biosignals: Electroencephalogram and Elec-
tromyogram
The two fundamental biosignals for this project are electroencephalogram (EEG)

and electromyogram (EMG) signals. In the following, their generation, characteris-
tics in time and frequency domain, and recording method are briefly presented.

3.2.1 Electroencephalogram signal

Electroencephalography is a technique to acquire brain potentials reflecting the
human cognitive behaviour. It was discovered by Hans Berger (1924) who proved
through different experiments that the synchronous activity of cortical pyramidal
neurons can be registered by applying electrodes on the scalp and amplifying the
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signal. The device used to acquire the cortical activity is the electroencephalogram
and it includes electrodes, conductive gel, amplifiers and Analog-to-Digital con-
verters. Electrodes are placed on the scalp with a small quantity of conductive gel
according to the International 10-20 system which positions adjacent electrodes
at a distance equal to the 10% or 20% of the total front-back (naison-inion) or
left-right (ears) distance(3.2).

NASION

Peee®
©-0-©-0-®
200 0g

INION

Figure 3.2: International 10-20 system. Taken from [24]

Each electrode is labelled with letters indicating the lobe (Fp—Pre-Frontal, F—
Frontal, C—Central, P—Parietal, O—Occipital, T-Temporal) and numbers referring to
the hemisphere (odd-left, even-right and “z” for the central line). EEG waveforms
have amplitude between 10 nV and 50011V and they can be distinguished by their
morphology, topography, symmetry and synchronism. In frequency, EEG spectrum
ranges between 0.1 Hz-100 Hz and it can be divided in different bands associated
to different behaviours and brain’s state:

o Delta waves (0.1 Hz—4 Hz): characterized by the highest amplitude due to the
strong synchronization of neurons generating cortical potentials; typical of
deep sleep, infants and patients in comatose state;

o Theta waves (4 Hz-8 Hz): related to subconscious activity, they occur during
deep relaxation and meditation; frequent in children under 13 years old and
abnormal in adults;

o Alpha waves (8 Hz—13 Hz): they normally occur in adults while relaxing; they
act as a bridge between conscious and subconscious state;
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o Beta waves (13 Hz-30 Hz): related to conscious actions and thinking; they
occur while talking, solving problems, judging and making decision and all
other activities requiring attention and concentration;

o Gamma waves (30 Hz—100 Hz): related to perception and full awareness; usual
while integrating sensory experiences and memory.

3.2.2 Electromyogram signal

Electromyography is the technique used to measure muscle response after nerve’s
stimulation through an instrument called electromyograph. Muscles in resting state
do not produce electric signals; while, when a stimulus occurs, a brief and wide
signal can be registered.

EMG recordings can be obtained by voluntary or stimulated contraction: the first
produce a random signal, while the second a deterministic signal.

(Bl

— Motor neuron |
in spinal cord |

Muscle fibers innervated
by a single motor neuron

J/

Figure 3.3: Motor Unit: the set of motor unit and muscle fibers. Taken from [25]

The set of alpha motor neuron and muscle fibers forms the Motor Unit(3.3),
considered the muscle’s functional unit. The axons departed from the spinal
cord propagate action potentials activating the muscle fibers; their post-synaptic
membrane is depolarized and then it produces different waveforms. The summation
of the action potentials is called Motor Unit Action Potential (MUAP).
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Different motor units in the same area influence the signal detected by an electrode;
then, it will record the summation of a MUAPS’ sequence, also called MUAPT
(Motor Unit Action Potential Train). Being non synchronous, this summation
generates interference, therefore, filtering is necessary to obtain the final EMG
signal.

EMG can be recorded in two ways:

o Surface EMG, non invasive techniques using two or more electrodes recording
the muscle activity from the surface above the muscle or skin. At least two
electrodes are needed because the final signal is given by the difference between
them.

o Intramuscular EMG, a more invasive technique recording signals from the
inside with needle electrodes and a reference surface electrode.

3.3 Readiness Potentials

ERPs reflect the summed activity of postsynaptic potentials produced by various
type of events each characterized by a particular waveform.[26] ERPs occurring in
temporal relation with movements are Motor Related Cortical Potentials (MRCP)
and they can be obtained from EEG and EMG recordings during repetitive move-
ments: the EMG gives time onsets to identify EEG traces that, averaged, gives
the MRCP. In 1965, Kornhuber and Deecke analysed MRCPs and identified three

main components:

» Readiness Potential (RP) or Bereitschaftspotential (BP), strictly related to
the motor intention;

 Pre-Motion Positivity (PMP), the predominant component over the hemisphere
ipsilateral to the motion side;

» Motor Potential (MP), corresponding to the movement site.

RPs are characterized by a slow negative potential preceding the motion onset of
2s which can be divided in: early component (~ 1.5s — 0.4s prior to onset), the
slow but gradual increase in negativity, symmetrical between the two hemispheres,
attributed to the supplementary motor area and premotor cortex; late component
(~ 0.4s — 0s before the onset), generated by the primary motor cortex.[27] The
amplitude and spatial focus of the RP depends on many particulars of the task as
preparatory states, motor intention, limb dominance, free movement selection, rate
of movement repetition or perceived effort.[28]
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3.3.1 Lateralized Readiness Potential

The Lateralized Readiness Potential (LPR) enhances the RP’s characteristic of
having larger amplitudes on the hemisphere controlateral to the side of the muscle
contraction, before the onset of the unilateral motor response. Kutas and Donchin
hypothesised that the beginning of lateralized activation corresponds to the moment
when the subject decides the side to move, i.e. the conscious intention to move
appears.

The most used method to obtain LPR is the Double Subtraction Method,
designed by De Jong (1988). It defines the motor asymmetry as the potential
difference between two opposite sites of the scalp due to lateralization and it
requires the RPs obtained performing the same task with right and left side:

1. the first difference is computed between the RPs of C3 and C4 channels for
both tasks;
(Rpcg — RP04)R (Rpog — RP04)L (31)

2. the second subtraction consists in the difference between the first amplitude
difference for the right side task and the left side and it is called Correct
Motor Asymmetry (CMA).

CMA = (RPc3 — RPca)r — (RPos — RPcu)r (3.2)

The second subtraction allows the elimination of the contribution due to the hemi-
spheres’ asymmetry and the CMA parameter indicates the extent of lateralization.
Several studies proved that the CMA can be obtained also during motor imagery
and differs only in the action execution. Rosembaum and Kornblum (1982) elab-
orated the Motor Priming Paradigm in which participants are subject to two
stimulus: the first provides information on particular aspects of the movement; the
second is to execute the motor task. It has been observed the rising of cortical
negativity in the controlateral side during the interval between the two stimuli
which indicates that the motor preparation is specific to the response, even if the
movement is just imagined.[29]

3.3.2 Libet’s Experiment

In 1983, Benjamin Libet and his associated conducted a series of experiments to
understand whether the conscious awareness of voluntary intention to act appears
at the same advance timing of Readiness Potentials. The participants to this
experiment were asked to repeatedly perform a simple movement, as flexing a
finger, in a spontaneous way while EEG and EMG signals were recorded. Moreover,
watching a clock rotating, they had to note the time at which they felt the urge to
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move (W time). Libet obtained an average of conscious intention time of 206 ms
before muscle contraction, a long time after RP onset, suggesting that the brain
prepares to act over a large period before the subject’s conscious willing. Libet
recognized then three distinguished moment in the RP: the conscious decision to
move (W), the unconscious brain event preparing the action (C) and the muscle

movement (M).[21][30][31]

1 Observe clock 2 Note clock position at time 3 Perform action
of conscious intention
(urge to act)

4 Report clock position at time
of conscious intention

The clock
hand was at
position 4

Readiness potential (1Y)

Time (s)

Movement
onset

Figure 3.4: Libet experiment and Related Potential. Taken from [30]
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Chapter 4

Readiness Potentials
recording

The essential biosignals for this project were recorded in Turin at Centro Puzzle
from male and female healthy volunteers and patients affected with hemiplegia,
aged between 18 and 65 years.

The signals were recorded and displayed on screen through the software Galileo
NT.

The type of biosignals recorded are:

» Electroencephalography (EEG) signals, acquired using an EEG cap with
a varying number of passive Ag/AgCl electrodes according to the adopted
protocol;

« Electromyography (EMG) signals, recorded with several adhesive elec-
trodes attached to areas of the muscles to contract;

« Electrooculography (EOG) signals, acquired by placing two adhesive
electrodes above and below each eye.

22



Readiness Potentials recording

Figure 4.1: Experimental setup.

4.1 Tasks and Protocol

Different protocols have been adopted over the years, each requiring different type
of tasks and experimental setups.

4.1.1 2012 - 2015 Protocol

A clock timer is displayed on the computer and the subject flexes the index finger
of the right hand every 10s for 6 min. In this way are obtained 40 epochs to use
for the ERP evaluation. More alternative tests were performed:

o Using the mouse: the movement is obtained by clicking the mouse button;

o Using both hands: the subject is asked to use both hands; the experimenter
indicates which hand to use every time;

o Short trials: the movement is performed every 5s to validate the hypothesis
of lack of free will;

e Bimanual: the subject uses both hands at the same time.

4.1.2 2015 - 2018 Protocol

The subject observes a clock projection on a screen and he/she is asked to repeat
a simple movement every 10s for 6 min and 40s. The movements can be: flexing
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the index finger, voluntary movement of foot or leg, the coordinated movement of
hand and leg, the patellar reflex of the knee. Some subjects were blindfolded and
they performed the tasks under indication of an operator.

4.1.3 2018 Protocol

The volunteers perform three tasks:

o Voluntary task: the subject moves the index finger in a time window of 10s—
13s after a sound. In this way, the subject has the opportunity to make
voluntary choice.

o Semi-voluntary task: the index finger movement must be performed as soon
as the subject hears the beep.

o Involuntary task: the patellar reflex is stimulated through a gavel by an
operator, but the subject does not hear the beep sound, then the moment of
the stimulus can not be predicted.

Voluntary Semi - Voluntary
@ N cue@ E
% %

Figure 4.2: 2018 Protocol tasks.

4.1.4 Dataset classification

The acquired data have been classified according to the subject information, the
type and mode of acquisition, and the instrumentation used. In this protocol, the
use of Labjack, i.e. a USB based measurement and automation device providing
digital input/output, allows the triggering for the movement while connected to
a Data Acquisition System (DAQ). The recordings’ classification involved the
evaluation of Labjack and EMG signals’ quality on a scale ranging from 0 to 3
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depending on the variability of the signal and the noise.

Each dataset has been named with a string of 45 characters composed by:

o 8 characters anonymizing the subject’s informations with the first letter
of the name, the first letter of the surname, the last digit of the recording
year, the last two digits of the year of birth, the month of registration and 0/1
depending whether the subject is male or female;

« 5 characters identifying the type of EEG electrode mounting: 32C18 stands
for 32 channels, while OBE12 for the bridge electrodes;

o 4 characters for the protocol used: A18C for 2018 protocol, B18C for 2015-
2018 protocol and VOPC meaning Very Old Protocol (2012-2015 protocol);

o 3 characters describing the condition of the subject between blindfolded
(FOL) and not (UNF);

« 5 characters identifying the type of task performed: voluntary (VOL18),
semivoluntary (SEM18) or involuntary (INV18);

« 4 characters classifying the task: right forefinger (RFOF), left forefin-
ger (LFOF), bimanual forefinger (BFOF), mouse click with the right hand
(RMOU), right leg (RLEG), left leg (LLEG), right foot (RFOO), left foot
(LFOO), right hand and leg (RHLE), left hand and leg (LHLE);

e 4 characters indicating the channel used for the EMG: EMG1 for channel 1,
EMG?2 for channel 2 and EMGX for channel without number;

» 4 characters to classify the quality for the EMG and Labjack indicated
respectively by E and L followed by 0/1/2/3.

4.2 Experimental setup

The recording of has been performed through the following instrumentation:

o Data Acquisition device: Galileo Suite, EB Neuro with Brain Explorer
amplifiers;

» Galileo Software processing and displaying the EEG traces;

e Stimulation system: Labjack and OpenSesame software for the acoustic
signal;

e Synchronization system: Labjack and photocoupler circuit;

25



Readiness Potentials recording

+ Recording tools: EEG cap, adhesive electrodes (4 for EOG signal and 2
for EMG signal), ground electrode for EMG (on the wrist for voluntary and

semi-voluntary tasks, on the ankle for involuntary) and two earlobes reference
electrodes for EEG;

« Additional accessories: conductive paste TEN20, abrasive paste NUPREP,
conductive EEG gel, a syringe with a blunt needle.

The subject sits on a raised chair which avoid the feet from touching the floor. In
one computer, it must be installed the software OpenSesame for starting the task
and emitting the acoustic signal. Another computer with the Galileo software must
be connected with the EEG cap and it allows to visualize, process and export the
signal. The subject is seated behind the first computer and on his left side.

The electrodes’ positioning starts from EMG and EOG sensors; then, earlobes
and wrist (or ankle) electrodes are mounted, using TEN20. Subsequently, the EEG
cap is set positioning Cz electrode in the middle between naison, inion and the two
earlobes. The skin is cleaned from sebum and dead cells with the abrasive paste
NUPREP and then the cap is filled with conductive gel with the blunt needle to
improve the signal conduction and improve the adhesion with the skin.

4.3 Software

The biosignals acquired are made compatible with the Matlab environment to go
under a signal processing improving the quality and eliminate disturbing elements
which could affect the classification.

The elaboration of Event Related Potentials exploits the EEGLAB toolbox with
a particular plug-in called MRCPLAB, created for this project.

4.3.1 EEGLAB

EEGLAB is an interactive Matlab toolbox developed by Swartz Center for Compu-
tational Neuroscience (SCCN). It is used to process continuous and event related
EEG, MEG and other electrophysiological signals. Its graphic interface (GUI)
permits the selection between different operations in time and frequency domain.
EEGLAB also offers modelling and visualization method for event-related brain
dynamics. Being an open-source platform, research programmers can share new
method with the publication of new plug-in functions.

26



Readiness Potentials recording

4 EEGLAB v14.1.2 - O X

File Edit Tools Plot 5tudy Datasets Help MRCPLAB ERPLAB ERPsets ¥

No current dataset

— Create a new or load an existing dataset:
Use "File > Import data" (new)
Or "File > Load existing dataset" (old)

- If new,
"File > Import epoch info" (data epochs) else
"File > Import event info" (continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset" (save dataset)

- Prune data: "Edit > Select data"

- Reject data: "Tools > Reject continuous data"

- Epoch data: "Tools > Extract epochs"

- Remove baseline: "Tools > Remove baseline"

— Run ICA: "Tools > Run ICA"

Figure 4.3: EEGLAB interface.

4.3.2 MRCPLAB

MRCPLAB is an EEGLAB plug-in developed specifically for this project. It
interacts and exploits some of the EEGLAB functions, but it also introduces new
ones more specific. Running EEGLAB; it is possible to use MRCPLAB from its
menu where the following functions are displayed:

o Import/Save data is used to import datasets in two ways:

— Import from ASCII file, it processes ASCII file data resampling and
filtering EEG, EMG and EOG signals, evaluating the events, initializing
the EEG structure with all the data needed and creating a .set file useful
for faster successive uploading;

— Import from .set file, it imports the EEG structure previously imported
and processed from the ASCII file.

o EEG Channel operation, it contains all the function useful to process the
continuous EEG signal:

— Channel data (scroll) opens a window where it is possible to visualize the
EEG and the onsets obtained from the EMG;

— Seek noisy channels permits to evaluate bad channels which has to be
rejected in order to obtain accurate results;

— Select or reject data allows the rejection of bad channels;
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— Artifact Correction detects and corrects artifacts through 1CA;

— Interpolate electrodes interpolates previously rejected channels considering
the closest electrodes;

« Spatial Filter, it allows to apply different type of spatial filters (SISF,SLSF,LLSF)
with a variable number of electrodes and coefficients (all equal or SNR depen-
dent); it is important to notice that SNR dependent coefficients can be used
only if SNR has been estimated previously, otherwise, spatial filtering can be
applied only with all equal coefficients;

e FEpoch operation, it contains operations applicable on epochs:

— Epoch and filter creates epochs according to the onsets evaluated through

the EMG;
— Jitter compensation allows to apply different methods for delay correction:

o RIDFE aligning the epochs applying residue iteration decomposition;

o Jitter compensation, which aligns all epochs according to a channel
selected by the user (Woody’s method);

o Jitter compensation 1, which aligns all epochs to a mean delay calcu-
lated over the seven channels of interests (Woody’s method);

o Jitter compensation 2, which performs alignment for different brain
zones (Woody’s method).

— ERP and SNR evaluation calculates the ERP and corresponding SNR
through averaging;

— ERP viewer plots the ERP and SNR.

o Topographies and Energy considerations plots the topographies and prints
energy consideration useful for LRP calculation.
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Chapter 5

Artifacts

In this chapter, it is presented the definition of artifact and the description some
types commonly found in EEG signals.

5.1 Definition of artifact

The electric signals recorded by EEG is attenuated due to the presence of tissue,
bone and hair, but also other sources can introduce noise. The term artifact in EEG
denotes any kind of signal not directly produced by human brain activity and can
be physiologic, electric or environmental. Physiologic artifacts are produced by the
body itself: eye movement, blinking, muscle contractions, heart beating, sweating,
head movements. Electric and environmental artifacts are generated by outside
sources mainly due to electrodes failures, cable movements or electromagnetic
interferences.[20][32][33]

Artifacts bring three problems to the RP calculation:

« the decrease of Signal-to-Noise Ratio (SNR) and, therefore, the decrease of
differentiation between conditions;

o the unlikelihood elimination of some artifacts by the averaging process due to
their systematic property especially in some conditions;

o the change of sensory input caused by ocular artifacts[20].

The main artifacts that can be present in an EEG recording are: ocular, muscular,
cardiac, sweat and electrode artifacts.
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Figure 5.1: Some of the artifacts which can affect the EEG signal. Taken from
[20]

5.1.1 Ocular artifact

Eye can be electrically modelled as magnetic dipole with positive charge in the
cornea and negative in the retina. Therefore, blinking or moving generates a
distortion of the electric field in the interested region. Generally, ocular movements
can be recorded by Electrooculogram (EOG), vertical for blinking or vertical
movements, or horizontal for lateral eyes movements.

Blinking. When the eyes blink, they slightly roll up (Bell’s phenomenon) and the
eyelid moves across the eyes acting as a variable resistor changing the voltage near
the eyes. The monophasic deflection produced is 50 pV-100 1V for 200 ms—400 ms.
The electrodes more affected by this artifact are the frontal ones, in particular Fpl
and Fp2, but also Fpz. They can be mistaken for frontal spike, but the characteristic
of the opposite polarity above and below the eyes can be useful to identify the
artifact and also remove it.
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Lateral movement. As long as the eye’s position does not change, the EEG will
register a static voltage gradient easily removed with a baseline correction. Instead,
when the eyes moves, the electrical potential of frontal electrodes will have different
behaviour for each side of the head. For example, moving horizontally to the left
causes positive potential on the left side electrodes and negative on the right side.
The majority of recorded eye movements usually are saccades, fast shifts in eye
position, consisting in sudden step from a voltage level to another where it would
remain until the eyes move back to previous position.[20)]
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Figure 5.6: Topographies of the ocular artifacts. Taken from [34]

5.1.2 Muscular artifact

Muscle contraction produces measurable rapid voltage fluctuations that can interfere
with EEG activity: chewing or the jaws’ contraction can affect temporal electrodes;
forehead’s muscles can add high-frequency noise to Fpl and Fp2; inferior occipital
and temporal electrode sites can be affected by muscles of the neck. The high
amplitude and frequency is usually visible and can be removed with a low-pass filter
with a cut-off frequency between 30 Hz and 100 Hz. However, it is always better to
have subjects relaxing the relevant muscles to minimise artifacts. Reflexive muscle
twitches are quite problematic because they are sudden, high-frequency voltage
changes limited to a very short time period and, therefore, very difficult to detect.
[20][33]
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Figure 5.10: Topographies of the muscular artifacts. Taken from [34]

5.1.3 Cardiac artifact

In some EEG recordings it is possible to observe the beating of the heart. It is
propagated through the carotid arteries and can be recorded by mastoid electrodes.
To avoid this artifact, it is possible to slightly move the position of mastoid electrode,
but nothing more than that. However, it is not systematic and it will just reduce
the overall SNR. It can be useful to record the electrocardiogram (ECG) and use it
to detect and remove the artifacts.[20][33]
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Figure 5.12: Topographies of the cardiac artifacts. Taken from [34]

5.1.4 Sweat artifact

When sweat begins to accumulate in glands, the skin impedance changes and
potentials arise for many seconds. The same artifacts can be caused by slow shifts
of electrodes if the subject moves. The waves overlapping the EEG signal have
frequency less than 0.5 Hz and do not follow a particular localization, it is possible
to correct them with a high-pass filter.[33]
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Figure 5.13: Slow waves due to sweating in EEG. Taken from [33]

5.1.5 Electrode artifact

Electrodes can give artifact caused by interference from the electrical activity or by
becoming loose. In the first case, the effect can be a high amplitude interference on
a single channel and it is possible to use a notch filter to remove it; while electrode
pop is sudden and distort the signal in a very unpredicted way.[33]
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Chapter 6

Artifact detection and
correction

The presence of artifacts can affect EEG signals and RP calculation misleading the
classification. It is important to distinguish artifacts from brain waves, but it can
be difficult because artifacts can be disorganized, intermixed with non-artifactual
signal or look similar to cerebral signals. Therefore, the first problem to face is the
detection of artifacts in EEG recordings. The second step is the minimization of
artifacts’ effects which can follow two ways: artifact rejection, which excludes trials
containing clear artifacts, or artifact correction, estimating the influence of artifacts
and then subtracting it. The former works well, but brings the risk of throwing
out a number of trials which reduce the statistical power of the averaged ERP;
on the other hand, the latter can exploit different procedures, but they may not
work well in all situations, generate distortions or not consider fast input changes.
Despite the cited drawbacks, one of the most popular and efficient method for
artifact detection and correction is Independent Component Analysis (ICA) which
exploits statistical properties to extract a set of components and isolate artifacts.
The automated algorithm implemented in MRCPLAB uses ICA and performs a
detailed analysis on components and applies correction.

In this chapter, it will be introduced the ICA, the analysis components in frequency
and time domain for detection, the enhancements applied to the algorithm and the
results obtained.

6.1 Independent Component Analysis

Before explaining how Independent Component Analysis works, it is better to
take a step back and remind how sources in brain mix. As previously explained,
the pyramid cells generate postsynaptic potentials whose summation allows the
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recording at the scalp.
The minimum conditions to have a measurable signal on the scalp are:

» the concurrent activation of a large number of neurons;
o the approximately same orientation of individual neurons;

 the increase of postsynaptic potentials from the same part for the majority of
the neurons;

o the same direction of current flow for the majority of neurons to avoid cancel-
lation.[35]

The current flows through volume conduction, i.e. brain tissues, from neurons to
the scalp. This causes spreading and voltage’s distribution gets wider with the
skull’s high resistance. Therefore, the waveform recorded from any electrode on
the scalp is a weighted sum of waveforms from different internal generators. The
weights are determined by the position and orientation of each source with respect
to the electrode site and the conductivity of brain tissues.[20]

The main interest is the estimation of individual sources from scalp recordings
which represents a forward problem without a single solution. Different mathe-
matical procedures were proposed and one of the most used today is Independent
Component Analysis.

ICA is a special case of Blind Source Separation (BSS), i.e. the unmixing process
not knowing any of the qualities of individual source signals. In particular, [CA
exploits temporal independence to separate the signals.

The most intuitive example to better understand ICA application is the “cocktail
party problem”: when we are at a party in a crowded room with music and a lot
of people talking, but we are interested in hearing what a single person, far from
us, is saying. Recording with microphones positioned in different places, ICA is
able to separate all the voices and sounds in the room and to focus the attention
on one voice or sound.
Considering the signal recorded at the scalp X, ICA looks for the unmixing matrix
W to decompose the signal into Independent Component signals U, also called IC
activations. Algebraically,

U=WX (6.1)

The inverse of the unmixing matrix, W1, is the mixing matrix which recaptures
the scalp data through multiplication with the IC activation matrix (X = W~tU),
as shown in 6.1. This source separation process is suited for

1. independent sources;
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Figure 6.1: Schematic flowchart of ICA process of decomposition and back-
projection. Taken from [35]

2. negligible propagation delay of the mixing medium;
3. analog sources with probability distribution not precisely Gaussian;
4. the number IC components equal to the number of sensors.

For EEG signals, the first two assumptions can be considered as satisfied: the
EEG dynamics can be modelled as a collection of statistically independent brain
process (1) and the volume conduction is instantaneous (2). The third assumption
is plausible for EEG sources usually sparsely active and then far from normal
distribution. The fourth assumption is questionable since it is not known the
effective number of statistically independent sources of EEG recordings. Then, it
is suggested to use an adequate amount of data to recognize independence and
obtain a successful ICA decomposition.[20][35]

6.2 Automated Algorithm

This thesis focuses on the enhancements of the automated algorithm dedicated to
artifact correction.
The process is composed by three fundamental steps:

1. evaluation of Independent Components;
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2. detection of artifactual components;

3. correction and reconstruction of the signal.

6.2.1 Evaluation of Independent Components

The matrix of recorded signals is imported to evaluate the Independent Components
through the function runica.m provided by EEGLAB. This function exploits the
algorithm developed by Bell and Sejnowski (1995). They studied a self-organising
learning algorithm which maximises the transferred information in a network of
non-linear units without assuming any prior knowledge of input distributions. The
non-linearities in the transfer function allow to find higher-order moments of the
input distributions and perform redundancy reduction between output units. In
other words, the neural network looks for the weights maximizing the joint entropy
and minimizing the mutual information.[36] In particular, the minimization of
mutual information is possible through the natural gradient studied by Amari,
Cichocki and Yang. Given the weights, their multiplication with the recorded
data separates statistically independent components. Therefore, given a signal
matrix ngp X t, where ngy, is the number of channels and ¢ the time expressed in
samples, from the runica function is obtained the activation matrix n;o X t, the
weights matrix n;c X ngp, and the sphere matrix ney, X ney (i.e. matrix removing
correlation between components).

activation = weights - sphere - EEGdata (6.2)

When EOG signals are available, they are added to the data matrix before ICA in
order to improve the ocular artifacts’ detection.

Once the activation components are obtained, it is possible to proceed to the
next step.

6.2.2 Detection of Artifactual Components

The algorithm aims at detecting ocular and muscular artifacts, and focal components
typical of noisy channels. The integration of EOG signals, when available, makes
possible the detection of ocular artifacts through the Pearson’s correlation coefficient.
It gives a measure of the linear dependence between two variables A and B as

cov(A, B)

0A0B

p(A, B) = (6.3)

where cov(A, B) is the covariance of the two variables, 04 and op their standard
deviation. The Matlab function corrcoeff evaluates p for each component and the
left and right EOGs. The IC with maximum p is identified as artifactual and
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corrected immediately. Successively, the algorithm evaluates specific features for
each IC in frequency and time domain:

o Fit-error: it describes the deviation of a component’s spectrum from a

prototypical curve and its shape defined as % where

The parameters ki, A and ko are strictly positive and they are determined

by three points in the log spectrum: value at 2 Hz, the local minimum in the
band 5Hz-13 Hz and the local minimum in the band 33 Hz—39 Hz.[37]

o Average log band power: the average logarithmic power is evaluated in
two bands: 8 Hz to 13 Hz for non-artifactual components and 25 Hz to 40 Hz
for muscular components. [37]

o Focal components: measure given by the maximum z-score of the mixing
matrix W~ [38]:
F =max (Z(W™)) (6.5)

o Kurtosis and Skewness: they are statistical properties of data; kurtosis
gives a measure of sharpness of a distribution’s peak and it is evaluated as

E{(z — 1)*}

K = -

-3 (6.6)
When a distribution has high kurtosis w.r.t. the normal distribution, it is
called leptokurtic, otherwise it is said platykurtic. Skewness measures the
symmetry of a probability distribution as follow

Sk — E{(z — )’} (6.7)

o3
They are used to analyse the signal and identify ocular and cardiac artifacts.

o Entropy: it can be interpreted as a statistical measure of randomness and it
is evaluated as

H == p(z)log,(p(z)) (6.8)

where p(z) is the probability of observing the activity values of z in the distri-
bution. The more unpredictable, i.e. with low probability values, components
have large entropies; on the other hand, high probability variables have small
entropy.
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The thresholds of fit-error and average log power have been evaluated statistically
through an Expectation-Maximization algorithm. The threshold for focal compo-
nents has been set to 1.5. Kurtosis, skewness and entropy have been normalized by
trimmed mean which normalizes a variable without considering the 0.1% of the
lowest and highest values. For those features, the threshold is set to 5.

These settings permit the individuation of artifactual components:

o ocular artifacts are detected through correlation coefficient with EOG;

» muscular artifacts are characterized by low fit-error and peak in the 25 Hz—
40 Hz band,;

 eye blinking, cardiac and intense muscular artifacts presents leptokurtic distri-
butions;

» noisy channels show high focal components;

o other unpredictable and unexpected artifacts will be characterized by high
entropy.

6.2.3 Correction and Reconstruction of the Signal

The final step after detection is correction of artefactual components by setting
them to 0. In this way, during the reconstruction of the EEG signal multiplying the
IC by the mixing matrix, the components considered artifacts will have a minimum
weight and will not influence the final result.

6.3 Results

The Artifact Correction algorithm is applied after rejecting bad channels to avoid
their influence in the analysis and detection. After correction, the bad channels
are interpolated with the closest ones. At this point, it is possible to apply
spatial filtering or to epoch the data. Spatial filters are powerful tools to identify
the lateralization of the RP (high-pass) or to increase the quality of the RP by
removing noise (low-pass). Since the goal of this thesis is to prove the validity of
the automated artifact correction algorithm, spatial filters are not applied and the
continuous data are divided into epochs of 8s identified by the EMG. The epoched
data undergo to an algorithm compensating the jitter between different epochs
and then are averaged to obtain the final RP and SNR. The SNR is obtained
considering the noise as the difference between even and odd epochs, and it is an
important feature in the machine learning algorithm.

In the following section, the results obtained with the original and enhanced version
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of the algorithm will be presented.

The datasets are chosen between voluntary, involuntary and semi-voluntary tasks of
the 2018 protocol, since the number of electrodes used is large enough to guarantee
a good ICA. For each datasets, the figures shown are: the topographies of all ICs,
giving an idea of the artifacts’ influence on components; the ICs more correlated
with EOGs; the kurtosis, skewness and entropy of each IC; the RPs and the
corresponding SNR of the most relevant channels (Fe3,Fez,Fe4,C3,Cz,C4,Pz) and
lines (Pre-motor,Motor,Left hemisphere,Right hemisphere, Median Rostro-Caudal).
Moreover, a table compares the components detected by each algorithm.

Note that the enhanced algorithm corrects first the IC detected with EOG and
then compute all the other features; therefore, the entropies of those components
are the highest, but they will not be reported as detected by entropy in the table.

From these results, it is possible to observe that the enhanced algorithm detect
the components cited previously with an increase of SNR values.

6.3.1 Voluntary

For voluntary tasks, the RP should show two clear peaks: one close to zero,
indicating the presence of intention; the second after zero, corresponding to the
motor activity. The SNR should be positive at least in the interval close to zero; if
the SNR is not positive, nothing can be said about the information in that time
period.

Dataset GF892070

Artifacts Previous AC | Enhanced AC
Ocular/EOG - 2,4
Muscular 7 24,33
Focal 6 34,35
Kurtosis and skewness All 1,5
Entropy All 1,3

Table 6.1: GF892070 Voluntary task: IC detected and corrected.
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GF892070 - IC Topographies

Figure 6.2: GF892070 Voluntary task: Topographies of IC.
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Figure 6.3: GF892070 Voluntary task: (a) and (b) show the EOG signals and
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skewness and entropy for each component and in red the threshold.
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Figure 6.4: GF892070 Voluntary task: RP and SNR obtained with Woody’s jitter
compensation method.
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Dataset AL858070

Artifacts Previous AC | Enhanced AC
EOG - 4,5
Muscular - 2
Focal 2,8,10,16,29 34
Kurtosis and skewness All 1,30,31,34
Entropy All -

Table 6.2: AL858070 Voluntary task: IC detected and corrected.

AL858070 - IC Topographies

Figure 6.6: AL858070 Voluntary task: Topographies of IC.
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51



Artifact detection and correction

AL858070 - RP AL858070 - SNR

—Fc3
Fcz
Fc4
C3
—Cz
—C4
Pz

nV

|
|
|
10 1 L L | 25
-5000  -4000  -3000  -2000  -1000 0 1000 2000 3000 -5000  -4000  -3000  -2000  -1000
ms ms

L L )
1000 2000 3000

Old Artifact Correction algorithm.

AL858070 - RP AL858070 - SNR
|

i
|
—Fc3 | 20|
Fcz :
Fc4 | 151
c3 }
Y i 10
—C4 } .
Pz | 1 MJ N
|
I 3 o
I I
y/ |
5 !
a4l | |
10 }
L T |
© 15+ |
I
8l | 20 F :
i I
10 . . . . I . . ) 25 . . . . I . . f
-5000  -4000  -3000  -2000  -1000 0 1000 2000 3000 5000 -4000  -3000  -2000  -1000 0 1000 2000 3000
ms ms

Enhanced Artifact Correction algorithm.

Figure 6.8: AL858070 Voluntary task: RP and SNR obtained with Woody’s jitter
compensation method.
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Figure 6.9: AL858070 Voluntary task: RP and SNR of averaged lines obtained
with Woody’s jitter compensation method.
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Dataset M1993011

Artifacts Previous AC Enhanced AC
Ocular/EOG 1,8,21 1,5
Muscular 1,8,21 8,9,13,14,20,28,30,32
Focal 3,4,6,13 33
Kurtosis and skewness All 2
Entropy All 3,4

Table 6.3: MI993011 Voluntary task: IC detected.
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Figure 6.10: MI993011 Voluntary task: Topographies of IC.
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Figure 6.11: MI993011 Voluntary task: (a) and (b) show the EOG signals and
the ICs more correlated with them; (c) reports the normalized value of kurtosis,
skewness and entropy for each component and in red the threshold.
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Figure 6.12: MI993011 Voluntary task: RP and SNR obtained with RIDE jitter
compensation.
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Figure 6.13: MI993011 Voluntary task: RP and SNR of averaged lines obtained
with RIDE jitter compensation.
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Dataset TC995011

Artifacts Previous AC Enhanced AC
Ocular/EOG 4,5,7,8,10,11,12,18,19,22,23,27 1,4
Muscular 10,12,27 8,9,12,13,15,16,30
Focal 3,6,13 32
Kurtosis and skewness All 5,15
Entropy All 2,57

Table 6.4: TC995011 Voluntary task: IC detected and corrected.
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Figure 6.14: TC995011 Voluntary task: Topographies of IC.

58



Artifact detection and correction

10 Left EOG signal 200 Right EOG signal
0 v W il w’ [ r” 1 J
| I Nl
ar 1 200 1
15F 4 w00l |
2l 1
. . 600 . . . . . . .
0 1 2 3 4 5 6 7 8 0 1 2 3 4 5 6 7 8
x10* x10*
IC1 " IC4
. - - - - " — 1 - - - - - - -
"] r "] | T 1of
-200 1 o WW
-10r
-400 - q
20
600 . . . . . . . %0 . . . . . . .
0 1 2 3 4 5 6 7 8 0 1 2 3 4 5 6 7 8
x10* x10*
(a) (b)
Temporal features
Kurtosi
20F T T T
10 I
, - in
5 10 15 20 25 30
Skewness
10 ‘ ‘
5
o - -
5 10 15 20 25 30
Entropy
20I;IIEI
0 5 10 = 15 20 25 30
IC
(c)

Figure 6.15: TC995011 Voluntary task: (a) and (b) show the EOG signals and
the ICs more correlated with them; (c) reports the normalized value of kurtosis,
skewness and entropy for each component and in red the threshold.
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Figure 6.16: TC995011 Voluntary task: RP and SNR obtained with RIDE jitter
compensation.
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Figure 6.17: TC995011 Voluntary task: RP and SNR of averaged lines obtained
with RIDE jitter compensation.

6.3.2 Semi-voluntary

The RP of a semi-voluntary task should present a lower peak of the intention due
to the smaller preparation time of the subject.
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Dataset AL858070

Artifacts Previous AC | Enhanced AC
Ocular/EOG 1,2,6,21,22,32 1
Muscular 2,6,21,22,32 -
Focal 134 3,34,35
Kurtosis and skewness All 5,8,12,14,35
Entropy All 3,5

Table 6.5: AL858070 Semi-voluntary task: IC detected and corrected.
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Figure 6.18: AL858070 Semi-voluntary task: Topographies of IC.
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Figure 6.19: AL858070 Semi-voluntary task: (a) and (b) show the EOG signals
and the ICs more correlated with them; (c) reports the normalized value of kurtosis,
skewness and entropy for each component and in red the threshold.
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Figure 6.20: AL858070 Semi-voluntary task: RP and SNR obtained with Woody’s
jitter compensation method.
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Figure 6.21: ALS858070 Semi-voluntary task: RP and SNR of averaged lines
obtained with Woody’s jitter compensation method.

6.3.3 Involuntary

The involuntary task presents RP with no intention peak and very low or negative
SNR.

65



Artifact detection and correction

Dataset FM893061

Artifacts Previous AC | Enhanced AC
Ocular/EOG 15 2,5
Muscular 3 31
Focal 10,15,23 32
Kurtosis and skewness All -
Entropy All -

Table 6.6: FM893061 Involuntary task: IC detected and corrected.
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Figure 6.22: FM893061 Voluntary task: Topographies of IC.
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Figure 6.23: FM893061 Involuntary task: (a) and (b) show the EOG signals and
the ICs more correlated with them; (c) reports the normalized value of kurtosis,
skewness and entropy for each component and in red the threshold.
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Figure 6.24: FMS893061 Involuntary task: RP and SNR obtained with RIDE
jitter compensation.
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Figure 6.25: FM893061 Involuntary task: RP and SNR of averaged lines obtained
with RIDE jitter compensation.
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Chapter 7
Slow drifts removal

Slow drifts affecting EEG are due to sweat, which generates skin potentials, or
to slight motion of electrodes from their position. These fluctuations can not be
suppressed through ICA, but, on the contrary, their effect may be emphasized.
High-pass filtering can be a solution, but it raises issues as the removal of slow
genuine cortical activity, distortions or spurious deflections. Another technique
mostly used is detrending which overcomes the issues caused by filters, but can be
applied in different ways. [39]

In this chapter, three types of detrending will be presented and compared.

7.1 Detrending

Detrending means evaluating a smooth function f(¢), usually a low order polynomial,
best fitting the signal x(t) and then subtracting it from the data:

y(t) = =(t) — f(#) (7.1)

The scale of fluctuations removed is controlled by the order of the polynomial f(¢)
which can be estimated by the least squared method.
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Figure 7.1: Detrending application. On the left, an EEG signal sample (black)
and its 10-th order fitting line (red); on the right, the detrended data. Taken from
[40]

The main problem of simple detrending is the sensitivity to glitches (due to
muscle, motion or electrodes) which affects the function fitting.
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Figure 7.2: Detrending application in presence of a glitch. On the left side, the
EEG signal (black) is affected by a glitch that is considered when the fitting line
(red) is evaluated; consequently subtracting the fitting line brings a distortion as
shown on the right. Taken from [40)]

7.2 Robust detrending

Robust detrending tries to overcome the sensitivity to glitches restricting the fit
to the intact part of the signal. It is used a weighted least square method to
evaluate the best fitting line and the weights can be given as a matrix or estimated
with a threshold (1).[40]
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Algorithm 1 Robust detrending algorithm.
Require: EEG signal z(t)
Ensure: detrended EEG y(t), outlier map w(t)
Initialize w(t) < 1
while not finished do
f(t) < x(t) fit to basis functions using weightsw(t)
a(t) « |a(t) — (1)
if |d(t)|/STD(|d(t)|) > threshold then
w(t) < 0
else
w(t) « 1
end if
end while

= fit (robust) —— detrended (robust)
raw =
mask ‘

|
200 400 600 0 200 400 600
time (s) time (s)

amplitude (mV)

-051
0

Figure 7.3: Robust Detrending application in presence of a glitch. On the left,
an EEG signal sample (black) affected by a glitch and its fitting polynomial (red);
on the right, the detrended data. Confronting with Figure 7.2, the fitting line does
not consider the glitch and subtraction does not introduce deformations. The grey
line indicates that the weights matrix is 0 for the glitch duration.Taken from [40]

However, the weak nature of ERP does not guarantee the masking out of
cognitive events of interest. In facts, robust detrending can affect negatively the
data for two reasons:

 the polynomial may fit weak but real ERP and subtract them,

 the partial fitting to the peak of an ERP may cause deviation from the baseline
activity with displaced and reversed patterns.[39]
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7.3 Masked-trial robust detrending

Joram van Driel, Christian N.L. Olivers and Johannes J. Fahrenfort extended robust
detrending method to overcome its issues, by masking out the data considered as
relevant events.[39] For a trial of 6s, they pre and post padded 25s and evaluated
the fitting polynomial with a mask excluding the 6s.

raw data
1 T T T T

Activity (au)
WN =0 =N W

| |
-20 -10 0 10 20 30
after 1st order polynomial removal

1

— — ! T ]

Activity (au)
N = 0O =N

[ 1

-20 -10 0 10 20 30

after 30th order polynomial removal
\ T T

'3 0 s st [ ‘W e A
;a: 05+ epoched trial §E§
| | | | |
-1 20 10 0 10 20 30

time in sec. —

Figure 7.4: Trial-masked Robust Detrending application on data of three elec-
trodes. On the top panel, raw data with the first order the polynomial fits (dotted
lines) obtained masking out the trial event(grey panel). In the middle, the data
after removing 1st order polynomials fits from the top panel. The dotted lines
show the 30th order polynomial fits on these data, from which the trial events were
masked out (grey panel in the background). At the bottom, data after removing
the 30th order polynomial fits. Finally, the middle trial in grey is segmented out
for further analysis. Taken from [39]

7.4 Results
The different methods have been tested on EEG data after interpolation.

o High-pass filtering. A 6-order Butterworth filter with cut-off frequency
0.1 Hz was designed with the butter Matlab function and applied with filtfilt
to each EEG channel in order to obtain zero phase distortions.
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Figure 7.5: Filter effect on an epoch of a single EEG channel.

Detrending. The Matlab function detrend has been applied to each channel.
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Figure 7.6: Detrending effect on an epoch of a single EEG channel.

Robust detrending. The robust detrending algorithm described in 1 is
applied with the function of Noise Tools toolbox nt detrend. The order has
been set to 10 after various tests.

74



Slow drifts removal
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Figure 7.7: Robust detrending effect on an epoch of a single EEG channel.

o Trial-masked robust detrending. The adam _detrend and__epoch function
in the ADAM toolbox implements the method described above, but, for
computational reasons, it has been modified to consider the entire continuous
EEG signal masking out the interval of 4s including the detected onset.
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Figure 7.8: Trial-masked robust detrending effect on an epoch of a single EEG
channel.

Comparing the methods, there is a slight difference between them, but not enough
relevant also in frequency domain. The most concerning consequences are then
those reported initially. Consequently, the choice is between robust detrending
and trial-masked robust detrending. In the end, the first has been chosen also
considering the computational time.
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In the following, the RP and SNR of the datasets previously considered are

reported here after detrending.

7.4.1 Voluntary
Dataset GF892070
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Figure 7.9: GF892070 Voluntary task: RP and SNR obtained with enhanced
Artifact Correction algorithm, Robust Detrending and Woody’s jitter compensation

method.
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Figure 7.10: GF892070 Voluntary task: RP and SNR of averaged lines obtained
with Artifact Correction algorithm, Robust Detrending and Woody’s jitter com-
pensation method.
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Dataset AL858070
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Figure 7.11: ALS858070 Voluntary task: RP and SNR obtained with Artifact
Correction algorithm, Robust Detrending and Woody's jitter compensation method.
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Figure 7.12: AL858070 Voluntary task: RP and SNR of averaged lines obtained
with Artifact Correction algorithm, Robust Detrending and Woody’s jitter com-
pensation method.
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Dataset M1993011
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Figure 7.13: MI993011 Voluntary task: RP and SNR obtained with Artifact
Correction algorithm, Robust Detrending and RIDE jitter compensation.

MI993011 - RP lines MI993011 - SNR lines

251 251

= Pre-motor Area }
Motor Area }
~ Right Hemisphere Area !
15 Left Hemisphere Area }
Median Rosto-Caudal Area }
|
|
|
|
|
|

20 1 20

> °f
[ [ A
3 E
0 S e i
| 5
5t |
| -10
| A Pre-motor Area
1ol y s Motor Area
= Right Hemisphere Area
15 } 20 Left Hemisphere Area
| Median Rosto-Caudal Area
20 . . . . | . . , 25 . . . T T T T ,
5000  -4000  -3000  -2000  -1000 0 1000 2000 3000 5000 -4000  -3000  -2000  -1000 0 1000 2000 3000
ms ms

Enhanced Artifact Correction algorithm.

Figure 7.14: MI993011 Voluntary task: RP and SNR of averaged lines obtained
with Artifact Correction algorithm, Robust Detrending and RIDE jitter compensa-
tion.
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Dataset TC995011
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Figure 7.15: TC995011 Voluntary task: RP and SNR obtained with Artifact
Correction algorithm, Robust Detrending and RIDE jitter compensation.
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Figure 7.16: TC995011 Voluntary task: RP and SNR of averaged lines obtained
with Artifact Correction algorithm, Robust Detrending and RIDE jitter compensa-
tion.
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7.4.2 Semi-voluntary

Dataset AL858070

AL858070 - RP AL858070 - SNR

o

nV
dB

-30

-40

-50

-60

10 L L L L L L , 70 L L L L L L ‘
-5000 -4000 -3000 -2000 -1000 1000 2000 3000 -5000 -4000 -3000 -2000 -1000 1000 2000 3000

ms ms

Figure 7.17: AL858070 Semi-voluntary task: RP and SNR obtained with Artifact
Correction algorithm, Robust Detrending and Woody'’s jitter compensation method.
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Figure 7.18: ALS858070 Semi-voluntary task: RP and SNR of averaged lines
obtained with Artifact Correction algorithm, Robust Detrending and Woody’s
jitter compensation method.
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7.4.3 Involuntary
Dataset FM893061
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Figure 7.19: FM893061 Involuntary task: RP and SNR obtained with Artifact
Correction algorithm, Robust Detrending and RIDE jitter compensation.
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Figure 7.20: FMS893061 Involuntary task: RP and SNR of averaged lines ob-
tained with Artifact Correction algorithm, Robust Detrending and RIDE jitter
compensation.
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Chapter 8
Study on hemiplegic patients

Hemiplegia is the temporary or permanent condition of partial paralysis that
patients may experience after brain injuries. The motor response on one side of
the body is weak or absent depending on the level of injury.

In this chapter, it is introduced the application of the pre-processing chain on
dataset acquired from patients affected by left hemiplegia (i.e. with injured right
hemisphere). Patients are asked to perform unimanual and bimanual tasks to prove
that motor intention is preserved and stronger on the non-hemiplegic hemisphere.
In this case, the recordings use 7 electrodes montage which do not allow a good ICA;
moreover, the EMG and EEG signals are noisier than those of healthy subjects,
then the pre-processing is done in a slightly different way.

8.1 Pre-Processing

The first step in pre-processing is the identification of movement onsets.

In MRCPLAB, the extraction of onsets exploits two EMG signals: the raw, from the
electromyograph, and the TKEOQO, obtained processing the raw EMG to maximize
the SNR. If the Labjack signal is available, it also will contribute.

For patient’s datasets, the EMG are noisy and sometimes the onsets are not
correctly identified; therefore, the movement onsets are extracted by looking at the
peaks of raw EMG for each dataset.

Secondly, the raw EEG is analysed to find artifacts: if a large peak affects all the
channels or it is temporally close to an onset, then the time onset is deleted and
not considered in epoching.

Then, different techniques are applied to clean the EEG signals:

« Kalman filter, it is widely used in signal processing to remove Gaussian
noise and, in this case, it is applied with Autoregressive model of order 6;
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Study on hemiplegic patients

e Peak correction, used to correct peaks not too close to the onset, it sets to
zero or interpolate samples larger than a given threshold (~ 10pV — 20 uV);

» Robust detrending, as previously described, it is used to correct slow drifts.

Depending on the dataset, these methods are used jointly or not used.
Successively, epoching and baseline correction are applied. Before averaging, it
is possible to compensate jitter with Woody’s method aligning all epochs to Fcz
channel.

8.2 Results

The bimanual task implies the intention of moving both hands and then a small
difference between Fc3 and Fc4 in the time interval —1s to 0s; while for the
unimanual task, intention (and movement) should be predominant in Fc3 (the
experiment involved the movement of the right finger and then the activation of
left hemisphere).

The results from the dataset MC373010 (8.1) and DV373010 (8.2) show what
described above: Fc3 is very close to Fe4 in the bimanual task; Fc3 is greater than
Fc4 in the unimanual.
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Figure 8.1: Hemiplegic MC373010 results: the bimanual task (a) shows a small
difference between Fc3 and Fc4 in the time interval —1s—0s; on the contrary, the
unimanual task (b) shows a larger difference.
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Figure 8.2: Hemiplegic DV373010 results: the bimanual task (a) shows a small
difference between Fc3 and Fc4 in the time interval —1s-0s; on the contrary, the
unimanual task (b) shows a larger difference.

The Fc3 signal in the bimanual task of the subject FR351070 (8.3) is smaller
than Fc4, which means that the intention on the right hemisphere requires a lot of
effort for the patient.
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Figure 8.3: Hemiplegic FR351070 results: the bimanual task (a) shows greater
value of Fc4 in —1s—0s since it requires a lot of effort for the patient; the unimanual
(b) has Fc3 values larger than Fe4.
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The recordings of two more subjects were analysed, but the noisy recording
of one task did not allow a paired comparison. However, the bimanual task of
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AI390071 (8.4) confirms the smaller difference between Fc3 and Fed; the RP of
unimanual task of AC390060 (8.5) has larger values of Fc3 w.r.t. Fc4 in the
considered time interval.
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Figure 8.4: Hemiplegic AI390071 result: the bimanual task has a small difference
between Fc3 and Fc4.
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Figure 8.5: Hemiplegic AC390060 result: the unimanual task has a larger difference
between Fc3 and Fc4.

Finally, to confirm the graphic results, the RMS Powers of Fc3 and Fe4 in
—1s-0s, and their differences were evaluated for each dataset and reported in 8.1,
8.2 and 8.3.
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Dataset ‘ Bimanual task
Prys|res | Prvs|res | Prys|res — Prvs|pes
MC373010 1.7381 1.4183 0.31987
DV373010 2.0796 2.0042 0.075316
FR351070 2.7942 4.0226 -1.2284
AI390071 4.3392 3.8438 0.49538
AC390060 - -

Table 8.1: RMS powers [1V] in the time interval —1s-0s

Dataset ‘ Unimanual task
Pruys|res | Prvs|res | Prys|res — Prvs|res
MC373010 | 0.95755 0.44591 0.51164
DV373010 2.5617 1.7201 0.84161
FR351070 1.2104 1.0114 0.19892
AI390071 - - —
AC390060 1.0697 0.67532 0.39438

Table 8.2: RMS powers [1V] in the time interval —1s-0s

PRMS‘FC?) - PRMS‘FC4

Dataset ‘ Unimanual ‘ Bimanual

MC373010
DV373010
FR351070
AI390071

AC390060

0.51164
0.84161
0.19892

0.39438

0.31987
0.075316
-1.2284
0.49538

Table 8.3: RMS powers [1V] in the time interval —1s-0s
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Chapter 9

Conclusions

This thesis focuses on improving the pre-processing chain, in particular the au-
tomated Artifact Correction and the detrending algorithms, to obtain Readiness
Potentials with higher quality allowing a more accurate classification. Moreover, it
is proposed the application of the pre-processing chain to datasets obtained from
hemiplegic patients.

Artifact correction enhancements allowed the objective detection of artifacts
exploiting frequency and statistical features of Independent Components. It allowed
improvements to the Signal-to-Noise Ratio and the shape of RPs. The limitations
of the algorithm are given by the Independent Components Analysis which require
an sufficient number of channels to adequately separate components. Therefore,
testing the algorithm with a larger number of channels may allow to study whether
more improvements may be applied to detect and correct other type of artifacts.

The detrending implementation does not produce visible improvements, but it
does not affect the RPs negatively. Therefore, including it in the pipeline will not
worsen the signal or introduce distortions.

Finally, the application of pre-processing to hemiplegic patients’ dataset allows
to study of Lateralized Readiness Potential and its features. The analysis of more
datasets can increase the statistical validity of the results.

Summarizing, more improvements in the pre-processing chain will certainly
allow a better classification of the motor tasks, but, more importantly, it will allow
the recognition of minimal state of consciousness and it will give more information
about the state of patients whose awareness cannot be easily proved.
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